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1. INTRODUCTION 

1.1. INTRODUCING OPENSPHERE 

1.1.1. OVERVIEW 

OpenSphere is a client application that supports and simplifies the daily work of people that have to 

deal with technical aspects within a complex system integration environment. EAI consultants, 

software developers, system integrators and testers through OpenSphere get offered an easy to use 

and powerful framework that speeds up analysis, development and testing of message based 

middleware, database dependent applications and custom components. OpenSphere is based on 

persistent projects that can freely be structured and configured to meet personal needs and 

preferences. 

 

The OpenSphere application offers a comprehensive but easy to use graphical user interface that lets 

you build projects with individual structure each, easily configure and execute components based on 

¢ƛōŎƻ wŜƴŘŜȊǾƻǳǎϰΣ 9a{ϰΣ Wa{Σ ǿŜō ǎŜǊǾƛŎŜǎΣ ŘŀǘŀōŀǎŜǎ ŜǘŎΦΣ ǿƛŘŜƭȅ ŜȄŎƘŀƴƎŜ Řŀǘŀ ŀƴŘ Ǌǳƴ ǘŜǎǘǎ 

with complex comparison rules.  

OpenSphere makes use of XML for comparing complex data structures (including nested XML), to 

maintain the project structure, single components and the application state over session boundaries. 
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omponents and projects can easily be exported to XML files and shared with other team members 

that may import them into their projects or may use them in other tools such as rvscript. 

The Application does not require any server installation itself but is ready to be used within a few 

minutes. The program is based on Java and can therefore be used on most operation systems. 

1.1.2. TESTING 

1.1.2.1. TESTING FRAMEWORK 

Effective testing of integration solutions starts right at the beginning of integration projects. The 

OpenSphere testing framework lets you develop tests in parallel to the software engineering process 

and maintain them during the whole product lifecycle. Reusability in software development is quite 

a common requirement; this software applies it on test modules as well.  

However, the OpenSphere automated testing framework does not only reuse proven 

components, it also provides comprehensive support in multiple domains. 

 Project specific test configuration and structuring  

 Test suites 

 Graphical test case editor 

 Graphical comparison rule editor 

 Message reporting, publishing and comparing for WebService, JMS and Tibco Rendezvous 

 Comparing of XML structures applying user configured comparison rules 

 Comparing of data retrieved from databases 

 Automatic reporting (publishing) of testing results 

 Running tests in batch mode through Apache Ant  

The result of an integration test is often limited to a statement reflecting its success and it hopefully 

provides some information on the source component and the data that got produced. Within an 

systems integration environment, a business process may fail due to an unavailable system, an 

incompatible interface, some version mismatch etc. If a test fails, we need more information then just 

above mentioned items, we are also interested in intermediate data, messages being exchanged, 

system availability and further details that will help us to quickly locate the source of a potential 

problem. And of course we also need detailed information about the cause of an error. 

OpenSphere enables you to build tests that generate such detailed reports that you will be able to 

quickly find most errors. The application contains a test engine driven by user defined test suites that 

contain a number of test cases with a graphical configurable test flow each. Comparison rules can be 

defined for entire messages through simple mouse clicks, this also includes nested XML structures. In 
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case of special needs, experts get full control over generated XPath expressions and can even extend 

the powerful comparison rules generated by default.    

1.1.2.2. AUTOMATED REGRESSION TESTING 

Supporting a proven testing methodology, OpenSphere lets you build sets of regression tests adjusted 

to your project specific requirements. Once the tests are built, they can be run at any time yielding 

immediate and detailed reports of the test results. 

This automated regression testing approach strongly improves the reliability of integration 

solutions. It is a key enabler for enterprises to adapt their systems to changing requirements on time 

and to budget. 

1.1.3. TIBCO INTEGRATION 

OpenSphere enables you to simply create, edit, change, save and record Tibco Rendezvous and Tibco 

EMS messages. Dedicated project tree nodes allow sending and receiving messages upon simple 

mouse click. Subscriber or consumer nodes can automatically reply to the received messages by 

sending predefined messages whereas other dynamic nodes act as powerful application simulators.        

1.1.3.1. PREREQUISITES 

Creating RV/EMS Publisher and Subscriber programs through OpenSphere does not require any 

knowledge of the Tibco program libraries nor programming language skills at all. It's as easy as to 

work with your preferred text editing program!  

1.1.3.2. PERSISTENCE AND SCRIPTING 

OpenSphere projects are stored in XML files and automatically reloaded at application start-up. TIBCO 

RendezvousTM messages recorded with the RV Message Detector or created through the RV Message 

Editor can individually be saved to XML files and be reused in other programs such as the RV Tool 

Collection from centeractive ag. The RV Subscriber and the RV Application Simulator modules as well 

can be configured to automatically write all recorded Rendezvous
TM

 messages to a reusable XML file.  

The configuration of program modules such as the RV Application Simulator can be exported to an 

XML file and be reloaded at any time into another project or be used in another application. Messages 

and configured programs can also be saved to the rvscript format, the all-purpose scripting tool for 

TIBCO Rendezvous
TM

. A program module present in the rvscript format is fully functional and behaves 

same as if run within the RV Tool Collection. Generated RV programs however are not supposed to be 

used in a productive environment but will help build complex systems but also greatly improve and 

speed up the development and test process within your company.      

1.1.4. DATABASE SUPPORT 

OpenSphere offers comprehensive database support in various functional areas. Specific SQL 

statements with an independent database connection may be added to a project tree as independent 
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nodes when their execution has to be repeated even over session boundaries. SQL statements can 

also be executed within test steps either to initialize tables to simulate a component or to compare 

values from different tables and even different databases.       

1.1.5. GRAPHICAL USER INTERFACE 

The OpenSphere graphical user interface (GUI) provides a single window that is equipped to handle 

the complete range of functionality provided. The driving component is the left located tree based 

browser that shows the user defined structure of the active project. Every tree node has its associated 

detail view that is displayed right to the project browser as soon as the node gets selected. By right 

clicking a node, a menu pops up that contains all functions that can be invoked on the specific node. 

The main window contains a menu bar and a tool bar that offer global functions or functions shared 

by different node types. Some of the detail views however contain additional tool bars offering 

context specific functionality. An optional displayed tabbed pane located on the windows bottom 

contains a variable number of worker panels.  

Extra non project specific tools such as the Tibco Rendezvous message detector may also be added to 

the window and stay there as floating dialog or can be docked as working panel.   

 

   Window Element Description 

Main Menu Provides access to many menus, such as File, Project and Tools. 

Main Toolbar Provides shortcuts to commands. Its buttons are grouped by functionality. 
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   Window Element Description 

Some of them are activated or deactivated respectively according to the 
current selected project node. 

Project Browser Displays the content (structure) of the current project. Place the mouse 
pointer on a node and press the left mouse button to get its relevant details 
displayed right to the project browser. Right-click any node to get a pop-up 
menu displayed that contains all available methods that can be invoked on 
that node. 
A double-click on most nodes displays their property dialog. 

Status Bar Informs you on status changes such as components getting started or 
navigation events happened.  

Node Detail View Shows the relevant runtime details of the current selected project tree 
node. The detail view of a folder node for example contains several internal 
windows representing the console of all direct depending executable nodes; 
the detail view of a test case detail view contains a tabbed pane showing 
different views on the test case each. Further properties of a node can be 
shown by right-clicking it and select the appropriate item from the popped 
up menu.  

Worker panel Shows information on processes running in the background or running in 
parallel to the interactive GUI process. Most worker panels are instances of 
a message pane (see below). 

1.1.5.1. MESSAGE PANES 

OpenSphere uses special panes to show messages on a specific topic; they are used to report work 

progress, results of comparison programs etc. Messages are displayed different colors depending on 

the message type. The message pane offers a table view and a text view; the table view summarizes 

information and may hide details that would all be visible in the text view. Details of a single table row 

are displayed in a dialog when a mouse click occurs on the row. To give a quick overview on 

something and for performance reasons, the table view is most often used by default. You can change 

between table and text view by selecting the appropriate item in the pop-up menu that appears when 

you right click inside the message pane.        

1.1.5.2. CONSOLES 

Consoles are message panels that show process 

activity and add functions accessible through a 

pop-up menu; they are used to observe and control 

the execution of processes. Consoles appear in the 

detail views of executable nodes. The appearance 

of consoles can be changed through the option 

dialog shown beside that gets displayed if you right 

click inside a console and choose the item Console 

hǇǘƛƻƴǎΧ from the pop-up menu. Alternatively 

those same options can be changed in the tools 

options dialog that appears when the item ¢ƻƻƭ Ҕ ¢ƻƻƭ hǇǘƛƻƴǎΧ from the main menu gets selected. 

The new settings are applied to all consoles within the application.      
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1.1.6. TOOL OPTIONS 

The basic behavior of OpenSphere can be customized through the Tool Options dialog that is invoked 

by selecting the menu item ¢ƻƻƭ Ҕ ¢ƻƻƭ hǇǘƛƻƴǎΧ from the main menu. The left located menu tree lets 

you select the item of your choice in order to change the related configuration.  

 

 

1.1.6.1. PATHS 

¢ƘŜ αtŀǘƘǎά panel lets you define the following file system options. 

Option Description 

Projects Directory Directory on the file system the application proposes for saving new 
OpenSphere projects 

Test Publishing Directory Default location (directory from the file system) to be proposed by the 
application when test suite results are published. If this option is not 
ǎŜǘΣ ǘƘŜ ƭƻŎŀǘƛƻƴ ǇǊƻǇƻǎŜŘ ǿƛƭƭ ōŜ ǘƘŜ άǇǳōέ ŘƛǊŜŎǘƻǊȅ ǿƛǘƘƛƴ ǘƘŜ 
current project folder.   

 

1.1.6.2. FILE 
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hƴ ǘƘŜ αCƛƭŜά panel you can define the following options. 

Option Description 

Open last project on 
program start 

Defines whether the last visited project should be loaded 
automatically if the application is launched   

Create backup copy when 
saving project 

Specifies whether a backup copy of the previous file content should 
be created each time the project file is saved. The backup copies are 
ǎŀǾŜŘ ƛƴǘƻ ǘƘŜ άōŀŎƪǳǇέ ŦƻƭŘŜǊ ƻŦ ǘƘŜ ŎǳǊǊŜƴǘ ǇǊƻƧŜŎǘ ŘƛǊŜŎǘƻǊȅΦ ¢ƘŜ 
name of the backup file has the following format 
<yyyyMMss_HHmmss>_<project file name> (i.e. 
20040728_154619_myProject.osp) 

Automatically define name 
and location of messaging 
component files  
 

Specifies whether message files are automatically created to a 
location that corresponds to the project structure.  
 

 If this option is selected and a property dialog of a messaging 
component (i.e. RV Publisher or JMS Consumer) is closed 
without indicating where to save the message(s), the messaging 
component node path will determine the location of the 
message file and the messages get stored automatically by 
OpenSphere when the property dialog is closed by pressing the 
άhYέ ōǳǘǘƻƴ. 

 If this option is not selected, the user must himself specify the 
location of the message file within a file chooser dialog.  

Create backup copy when 
saving messages 

Specifies whether a backup copy of the previous file content should 
be created each time a Rendezvous message file is saved. The backup 
copies are saved into the same directory as the original message. The 
name of the backup file has the following format 
bck_<yyyyMMss_HHmmss>_<messageFileName> (i.e. 
bck_20040728_162613_employees.rvm) 

Store text data within 
CDATA section 

Indicates that text data contained in message components has to be 
put within CDATA sections when a message is transformed to XML. If 
this radio box is selected and some text data contains itself a 
character sequence that terminates the          CDATA section 
("]]>"), all special character get escaped and the data is not set within 
a CDATA section. 

Use escape characters when 
storing text data 

Specifies that text data contained in message components get all 
special characters escaped when a message is transformed to XML. 

1.1.6.3. GUI 

{ŜƭŜŎǘ ǘƘŜ αD¦Lά panel for defining options related to the behavior and appearance of the graphical 

user interface. 

Option Description 

Message Editor 
Hide comparison rule panel 
by default 

Determines whether the comparison rule panel in the message list 
editor shall be shown or hidden by default when switching to 
comparison rule editing (menu item View > Show Comparison Rules). 
If this check box is selected, the user is still enabled to show the 
comparison rule panel at any time by simply activating the related 

toggle button  on the editor tool bar.  
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Option Description 

XML Editor 
Hide attribute panel by 
default 

Indicates whether the attribute panel located below the XML tree 
structure panel has to be hidden when opening a new XML editor. 

XML Editor 
Hide comparison rule panel 
by default 

Determines whether the comparison rule panel in the XML editor has 
to be shown or hidden by default when switching to comparison rule 
editing (menu item View > Show Comparison Rules). If this check box 
is selected, the user is still enabled to show the comparison rule 

panel at any time by simply activating the related toggle button  
on the editor tool bar. 

Worker Panel 
Keep message detector tab 
always in front 

Select this check box if you want to keep the Rendezvous message 
detector worker panel to stay always in front when new tabs get 
added. This is especially useful when running a series of test suites 
that get all their own worker panel added to the bottom of the 
application. That allows the tester to monitor the ongoing overall 
message flow.   

1.1.6.4. CONSOLE 

¢ƘŜ ά/ƻƴǎƻƭŜέ ǇŀƴŜƭ ƭŜǘǎ ȅƻǳ ŘŜŦƛƴŜ ǘƘŜ ƭƻƻƪ ŀƴŘ ŦŜŜƭ ƻŦ ŎƻƴǎƻƭŜǎΦ /ƻƴǎƻƭŜǎ ŀǊŜ ƳŜǎǎŀƎŜ ǇŀƴŜƭǎ ǘƘŀǘ 

show process activity and add functions accessible through a pop-up menu; they are used to observe 

and control the execution of processes. Consoles appear in the detail views of executable nodes. 

Property Description 

Screen Buffer Size Specifies the number of messages the console should keep in the buffer. If a 
new message gets added to the console and the buffer size exceeds, the oldest 
message gets removed. When choosing the buffer size, consider the number of 
executable nodes within your OpenSphere projects. Every executable node has 
its own console that may buffer message up to the specified size. Choosing a 
high buffer size with lots of executable nodes may cause the application to run 
out of memory.   

Background Color Determines the background color of the consoles. 

Selection Color Determines the background color of the selected row or message  

Text Color 
Information 

Specifies the text color to be used for displaying messages of type 
άLƴŦƻǊƳŀǘƛƻƴέ 

Text Color 
Warnings 

Specifies thŜ ǘŜȄǘ ŎƻƭƻǊ ǘƻ ōŜ ǳǎŜŘ ŦƻǊ ŘƛǎǇƭŀȅƛƴƎ ƳŜǎǎŀƎŜǎ ƻŦ ǘȅǇŜ ά²ŀǊƴƛƴƎέ 

Text Color Errors {ǇŜŎƛŦƛŜǎ ǘƘŜ ǘŜȄǘ ŎƻƭƻǊ ǘƻ ōŜ ǳǎŜŘ ŦƻǊ ŘƛǎǇƭŀȅƛƴƎ ƳŜǎǎŀƎŜǎ ƻŦ ǘȅǇŜ ά9ǊǊƻǊέ 

Selected Text 
Color 

Determines the text color of a selected row or message  

Font Defines the overall font to be used in the console 

1.1.6.5. WEB SERVICE 

This panel lets you define the framework to be used when creating new web service clients. The 

framework mainly provides tools for generating Java classes out of the WSDL definition. Once a web 

service clƛŜƴǘ ƛǎ ŎǊŜŀǘŜŘΣ ǘƘŜ ŦǊŀƳŜǿƻǊƪ ƛǘΩǎ ōŀǎŜŘ ƻƴ Ŏŀƴƴƻǘ ōŜ ŎƘŀƴƎŜŘ ŀƴȅƳƻǊŜΦ    

Property Description 

Apache Axis Determines that Apache Axis 1.4 gets used  
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Apache CXF Determines that Apache CXF gets used 

 

1.1.6.6. JMS PROVIDER 

¢ƘŜ άWa{ tǊƻǾƛŘŜǊέ ǇŀƴŜƭ ƭŜǘǎ ȅƻǳ ŘŜŦƛƴŜ ǎƛƴƎƭŜ Wa{ ǇǊƻǾƛŘŜǊǎ ƛƴ ƻǊŘŜǊ ǘƻ use OpenSphere with the 

JMS products of your choice. The top located list on the panel contains an item for every JMS Provider 

defined for the current instance of OpenSphere. Using the right located buttons, you can simply add a 

new JMS provider definition or you can remove the current selected one. 

When configuring JMS providers, you basically tell OpenSphere where to find the Java classes that are 

required to act as a client towards a particular JMS implementation (product). Depending on the 

available classes, you then define one to three connection templates and optionally also a admin 

class. The connection templates are then available within OpenSphere when you define a JMS 

component (i.e. JMS Message Consumer).     

¢ƘŜ άWa{ tǊƻǾƛŘŜǊ 5Ŝǘŀƛƭǎέ ōƻȄ ǎƘƻǿǎ ǘƘŜ ŘŜǘŀƛƭǎ ƻŦ ǘƘŜ ŎǳǊǊŜƴǘ ǎŜƭŜŎǘŜŘ Wa{ ǇǊƻǾƛŘŜǊ ŀŎŎƻǊŘƛƴƎ ǘƻ 

the table below. 

Property Description 

Name bŀƳŜ ƻŦ ǘƘŜ Wa{ ǇǊƻǾƛŘŜǊ όƛΦŜΦ ά¢ƛōŎƻ 9a{έύ ǘƘŀǘ Ƴǳǎǘ ōŜ ǳƴƛǉǳŜ ōŜǘǿŜŜƴ ŀƭƭ 
JMS provider definitions. The JMS provider name gets referenced by JMS 
components you define in your project (i.e. a JMS Queue Browser) but also 
from within JMS listener definitions mad for the Message Detector. Therefore 
be careful when choosing the name and avoid changing it if it is still referenced 
somewhere. If you may think of working with different releases of the same 
JMS product simultaneously, it is advised to include the release number in the 
name straight from the beginning.   

Java Libraries This list contains all Java archives (.jar and/or .zip files) used by a client of the 
defined JMS provider. Since OpenSphere acts as a client through its 
configurable components (Message Detector, JMS Message Producer etc.), it 
needs to have access to related Java classes. Such classes are the factory classes 
for creating connections to the related JMS server or admin classes that let you 
retrieve information about available destinations. 
 
When adding a new JMS provider definition, OpenSphere automatically adds 
the Java archive files present in the folder 
<OPENSPHERE_HOME>/lib/jmsAdmin .  These files contain a set of 
predefined admin classes for known JMS provider. From the file chooser dialog 
that pops up, you now have to select the required provider specific Java archive 

files. Using the  button, you can add missing Java archive files at any time 

later or you can remove selected unnecessary ones using the  button. 
 
OpenSphere scans the specified Java archive files for factory classes and admin 
classes and provides them within the appropriate bottom located tab labeled 
άWb5LέΣ άvǳŜǳŜέΣ ά¢ƻǇƛŎέ ƻǊ ά!ŘƳƛƴέ for further selection. 
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Property Description 

JNDI This panel lets you define a template for JMS connection definitions through 
the Java Naming and Directory Interface (JNDI).  
 
The Initial Context Factory combo box contains all classes found in the defined 
Java archive files that implement the interface 
javax.naming.spi.InitialContextFactory .  
 
The Available Properties list contains all available JNDI properties except the 
ones that are already assigned to the selected initial context factory. 
 
The Selected Properties table shows the properties already assigned to the 

selected initial context factory. By pressing the button or the button, you 
can easily add or remove single or multiple selected properties. The buttons 

 and  let you change the position of single assigned properties. You can 
define a default value for individual properties if you like, this is especially 
useful if the final property value needs to comply to a certain pattern (i.e. 
άtibjmsnaming://host:portέύΦ    

Queue This panel lets you define a template for JMS queue connection definitions.  
 
The Connection Factory combo box contains all classes found in the defined 
Java archive files that implement the interface 
javax.jms.QueueConnectionFactory.   
 
The Available Properties list contains all properties available for the selected 
queue connection factory except the ones that are already assigned to it. 
 
The Selected Properties table shows the properties already assigned to the 

selected queue connection factory. By pressing the button or the button, 
you can easily add or remove single or multiple selected properties. The 

buttons  and  let you change the position of single assigned 
properties. You can define a default value for individual properties if you like, 
this is especially useful if the final property value needs to comply to a certain 
ǇŀǘǘŜǊƴ όƛΦŜΦ άtcp://host:7222έύΦ    

Topic This panel lets you define a template for JMS topic connection definitions.  
 
The Connection Factory combo box contains all classes found in the defined 
Java archive files that implement the interface 
javax.jms.TopicConnectionFactory .  

 

The Available Properties list contains all properties available for the selected 
topic connection factory except the ones that are already assigned to it. 
 
The Selected Properties table shows the properties already assigned to the 

selected topic connection factory. By pressing the button or the button, 
you can easily add or remove single or multiple selected properties. The 

buttons  and  let you change the position of single assigned 
properties. You can define a default value for individual properties if you like, 
this is especially useful if the final property value needs to comply to a certain 
pattern όƛΦŜΦ άtcp://host:7222έύΦ    
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Property Description 

Admin This panel lets you define an administrator class used to show and retrieve 
available destinations.  
 
The Admin Class combo box contains all classes found in the defined Java 
archive files that implement the interface 
com. centeractive .opensphere.msg.jms.admin.JMSAdmin . If 
the file openSphereJMSAdmin_n_n.jar  from the directory  
<OPENSPHERE_HOME>/lib/jmsAdmin  is defined in the list of java 
libraries, a few admin classes for well-known JMS providers will be available by 
default. If there is no predefined admin class available for your JMS provider, 
you can write your own by implementing above mentioned JMSAdmin 
interface. The javadoc for the JMSAdmin interface can be found in the 
appendix at the end of this document, the binary code is contained in the 
openSphere_n_n.jar  that is located in the folder 

<OPENSPHERE_HOME>/lib.  

1.1.6.7. DATABASE 

¢ƘŜ ά5ŀǘŀōŀǎŜέ ǇŀƴŜƭ ƭŜǘǎ ȅƻǳ ŘŜŦƛƴŜ ƻǇǘƛƻƴǎ ǊŜƭŀǘŜŘ ǘƻ ŘŀǘŀōŀǎŜ ŎƻƴƴŜŎǘƛƻƴs, please consult the 

sectioƴ ά5ŀǘŀōŀǎŜ {ǳǇǇƻǊǘέΦ 
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1.2. GETTING STARTED 

To work with OpenSphere, you must first create a project by choosing the menu item File > New 

Project. Within the displayed project options dialog you have to enter a project name and a working 

directory. Optionally you can define project default settings such as the Tibco Rendezvous transport, a 

repository instance etc. All the entered options can be changed later; you can for example easily 

switch to another repository instance when your environment is moving from development to test.    

 

When the dialog is closed by pressing the OK button, the project node appears in the project browser, 

ready to get dependent nodes created underneath. Such nodes are added using the Project menu 

within the main menu or by right-clicking on the project node and choosing the appropriate add item. 

The project structure can freely be composed and adapted to the needs of the user. Direct dependent 

nodes of the project node can be folders, test suites or databases; folder nodes may contain other 

folders or any kind of executable node; test suites contain 1-to-n test cases etc. Dependent nodes 

may themselves contain a certain number of dependents unless they are leafs. 

When a new node is added as a dependent of an existing node, its property dialog is shown and lets 

you configure the component. This property dialog can be shown again at any time by right-clicking 

ǘƘŜ ƴƻŘŜ ŀƴŘ ŎƘƻƻǎƛƴƎ ΨtǊƻǇŜǊǘƛŜǎΧΩ ŦǊƻƳ ǘƘŜ ǇƻǇǇŜŘ ǳǇ ƳŜƴǳ ƻǊ ōȅ ŘƻǳōƭŜ-clicking a selected node. 

Most property dialogs are non-modal to allow you to compare and copy the settings between 

different modes.   
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2. OPENSPHERE PROJECTS 

To take full advantage of the comprehensive functionality of the application, you will have to work 

within a project. An OpenSphere project is a freely composed hierarchical tree structure containing 

group nodes and atomic nodes (leafs) that offer specific functionality each. Meanwhile a folder node 

simply provides a view on console windows of dependent executable nodes (multiple-document 

interface), a simulator node for example is fully configurable and acts like an independent server 

program. 

2.1. PROJECT STRUCTURE 

2.1.1. FILE SYSTEM 

 When a new project is defined in the project property dialog a project folder 

(folder named Welcome for the sample beside) is automatically created on the 

file system within a directory you are free to choose. The name of the project 

folder is identically with the project name that was defined in the dialog. The 

project folder initially contains the project file and some reserved folders 

OpenSphere uses by default for exporting node definitions, publishing test suite 

results, dynamically generating files and storing backup files of the project. The project structure on 

the file system usually will grow as new nodes are added to the project. 

OpenSphere project files have the extension .osp and contain the XML formatted definition of the 

project made through the graphical user interface. Resources such as Tibco RendezvousTM messages 

that can be defined in the property dialogs of specific program tree nodes are not stored within the 

project file however. The resources are saved as independent files (i.e. extension .rvm for Tibco 

RendezvousTM message files) and the project file will get that file path written to it. This path is a 

relative reference to the project folder in case the resource file is underneath that folder or it is an 

absolute path in case the resource file is stored somewhere else (outside the project file structure). 

In order to be able to easily move and/or exchange entire OpenSphere projects without losing any 

references to resources, it is recommended to store all your resources underneath the corresponding 

project folder.  

2.1.2. PROJECT BROWSER 

The project structure appears as tree within the Project Browser at the left side of the OpenSphere 

application, the top most and first appearing node being the project node. The project structure is 

built by adding nodes to group nodes. The project node itself allows you to add a restricted number of 

dependent node types, the so called top level nodes (folders, test suites and databases). Other group 

nodes accept dependent node types that make sense in the given context; a test case node for 

example will only accept test step nodes.  

Every node within the project tree can be exported to a file and imported to other projects or simply 

to another location within the same project. Exported nodes are of XML format and can easily be 

shared with other people or archived for further use depending on your needs. Beside this feature, 
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every node offers other functionality that is accessible through the application toolbar (common 

functions only) or through the pop-up menu that appears when a right mouse button click occurs on 

the node. A left mouse button double click on a selected node brings up its property dialog that lets 

you customize the node.    

2.2. PROJECT TREE NODES 

 The project node is the root of each project. The subsequent described nodes may appear in the 

project tree structure. Only common folders, databases and test suites can be added as direct 

dependents to the project node.  

2.2.1. PROJECT PROPERTIES 

When creating a new project through the menu item File > New Project, the project properties dialog 

gets displayed automatically and requires some data to be entered. The same dialog can be shown at 

any time later by selecting the menu item tǊƻƧŜŎǘ Ҕ tǊƻƧŜŎǘ tǊƻǇŜǊǘƛŜǎΧ from the main menu.  

 

 
 

2.2.1.1. GENERAL 

hƴ ǘƘŜ αDŜƴŜǊŀƭά panel you define the name and location of the OpenSphere project. 
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Option Description 

Project Name Name of the OpenSphere project. When a new project is created, the 
ǇǊƻǇƻǎŜŘ ǇǊƻƧŜŎǘ ƴŀƳŜ ƛǎ άbŜǿέ ŀƴŘ ƛǎ ōŜǎǘ ǊŜǇƭŀŎŜŘ ōȅ ǎƻƳŜ ƳƻǊŜ 
appropriate name. Changing the project name for a new project does 
automatically change the name of the project directory in the text field 
below.  
When a project file is created for a new project, it gets the name of the 
project together with the extension .osp and it is placed in the project 
directory.     

Project Directory Directory on file system that gets the project data written to it by default. 
hǇŜƴ{ǇƘŜǊŜ ǇǊƻǇƻǎŜǎ ŀ ŘƛǊŜŎǘƻǊȅ ǘƘŀǘ ƛǎ ŎƻƳǇƻǎŜŘ ōȅ ǘƘŜ ōŀǎŜ άtǊƻƧŜŎǘǎ 
5ƛǊŜŎǘƻǊȅέ ŘŜŦƛƴŜŘ ƛƴ ǘƘŜ ǘƻƻƭ ƻǇǘƛƻƴǎ ŘƛŀƭƻƎ όάtŀǘƘǎέ ǘŀōύ and a dependent 
folder that has the same name as the project (tool options can be changed 
ǘƘǊƻǳƎƘ ǘƘŜ ƳŜƴǳ ƛǘŜƳ ¢ƻƻƭ Ҕ hǇǘƛƻƴǎΧύΦ 
The project directory can be set for new projects only. For existing projects, 
it is the folder that contains the project file.    

 

2.2.1.2. TIBCO 

¢ƘŜ α¢ƛōŎƻά ǇŀƎŜ ƭŜǘǎ ȅƻǳ ŘŜŦƛƴŜ ǇǊƻƧŜŎǘ ŘŜŦŀǳƭǘ ǎŜǘǘƛƴƎǎ ŦƻǊ ¢ƛōŎƻ ōŀǎŜ ǇǊƻŘǳŎǘǎ ŀƴŘ ǘƘŜ hǇŜƴ{ǇƘŜǊŜ 

Adapter, which is used for accessing meta data defined in a Tibco repository.  

Option Description 

Tibco Rendezvous 
Tranport 

Tibco Rendezvous
TM

 transport settings used for sending and receiving 
messages from inside the project.  

Rendezvous String 
Encoding 

Character encoding for converting between Java Unicode strings and 
Rendezvous wire format strings. The default encoding depends on the 
locale where Java is running.  

2.2.1.3. TIBCO / RENDEZVOUS (ADVANCED) 

{ŜƭŜŎǘ ǘƘŜ α¢ƛōŎƻ κ wŜƴŘŜȊǾƻǳǎ ό!ŘǾŀƴŎŜŘύά ǇŀƎŜ ǘƻ ŘŜŦƛƴŜ ŀdvanced options for Tibco Rendezvous.  

Custom Editors 

In the top area of the panel, you can define a number of custom editors for specific rendezvous field 

data. Those editors get used when Rendezvous messages will be edited in the message editor dialog. 

SƛƳǇƭȅ ǇǊŜǎǎ ǘƘŜ άŀŘŘέ ōǳǘǘƻƴ ŀƴŘ ŘŜŦƛƴŜ ǿƘŀǘ custom editor to use for what kind of field data. Every 

definition must specify the editor class together with one or several field identifiers such as name, ID 

or data type. OpenSphere always uses the editor where the most field identifiers match.   

Option Description 

Field Name Name of the Rendezvous message field 

Field ID ID of the Rendezvous message field 

Data Type Data type of the Rendezvous message field 

Editor Class Name The full name of a class that extends the editor class 
com. centeractive .opensphere.msg.JCustomDataEditor . This 
abstract class has the following methods that are invoked by OpenSphere to set 
Rendezvous field data and to determine whether this data is editable. In case it 
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is editable, OpenSphere makes sure, the edited value gets written back to the 
corresponding Rendezvous message field. 
 
public boolean isEditable()  
 

This method indicates whether the field data is editable. If this method returns 
true, the method getData has to be overwritten to return the data contained in 
the editor 
 
public Object getData()  
 

This method returns the data contained in the editor. This method gets invoked 
by OpenSphere only in  case the method isEditable returns true 
 
abstract public void setData(Object data)  
 

This method sets the data to be contained in the editor. This method gets 
invoked by OpenSphere each time the Rendezvous field node gets selected in 
the message editor 

User Data Type Handler (Encoder/Decoder) 

In the bottom area of the panel you can define a class that is responsible for encoding and/or 

decoding Rendezvous user types. 

Option Description 

Handler Class 
Name 

The full name of a class that implements the interfaces 
com.tibco.tibrv.TibrvMsgEncoder  and/or 
com.tibco.tibrv.TibrvMsgDecoder  

User Data Types Comma separated integer values between TibrvMsg.USER_FIRST (128) and 
TibrvMsg.USER_LAST (255) each. The class TibrvMsg  is in the package 
com.tibco.tibrv . 

2.2.1.4. WEBSERVICES 

Webservices in OpenSphere by default are based on the Apache Axis 1.4 framework. The Axis default 

bean serialization model used by OpenSphere isn't robust enough to handle every case of data 

serializing/deserializing. Sometimes out of your WSDL file, non-bean Java classes get generated, which 

will have to be mapped to and from XML. Some custom XML schema types may be present that need 

to be mapped into Java in particular ways. Axis gives you the ability to write custom 

serializers/deserializers, OpenSphere lets you assign them to single projects. Custom type mappings 

get configured on the α²ŜōǎŜǊǾƛŎŜǎέ page; you can add or remove single definitions and modify the 

entries in a form like panel. 

Field Description 

Java Class Name The name of the Java class to be serialized of deserialized. The default value 
is java.lang.String. 

XML Namespace URI The namespace of the XML element the Java class has to be serialized to or 
deserialized from. The default value is 
http://www.w3.org/2001/XMLSchema. 

XML Local Name The local name of the XML element the Java class has to be serialized to or 
deserialized from. The default value is anyType 

Serializer Factory Class The Java class name of the serializer factory which provides the serializer to 
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Name be used to marshal an object of the specified java class (i.e. java.lang.String) 
into XML. The default value 
org.apache.axis.encoding.ser.SimpleSerializerFactory points to an existing 
Axis deserializer factory class. 

Deserializer Factory 
Class Name 

The Java class name of a deserializer factory that provides the deserializer 
to be used to unmarshall XML into the correct Java class. The default value 
org.apache.axis.encoding.ser.SimpleDeserializerFactory points to an 
existing Axis deserializer factory class. 

Please read about custom serialization in the Axis (1.X) documentation to know more details about 

the specific settings.   

Data mapping between XML and Java classes fails if substitution variables are defined for a numeric 

XML element. In such a case you need to select the chŜŎƪōƻȄ ƭŀōŜƭŜŘ άIgnore marshaling errors when 

substitution variables are present in complex data structureέΣ ǿƘƛŎƘ ŀǇǇŜŀǊǎ ŀǘ ǘƘŜ ōƻǘǘƻƳ ƻŦ ǘƘŜ 

panel. Please be aware that data types are not checked at all if this option is selected.             

2.2.2. EXPORTING AND IMPORTING NODES 

Every dependent project node (except the database node) can be exported to an XML file through the 

άŜȄǇƻǊǘέ ōǳǘǘƻƴ  located in the main toolbar or through the node specific pop-up menu. This 

allows you to share components with other users or to reuse them in other OpenSphere projects.  

 

¢ƻ ƛƳǇƻǊǘ ŀ ƴƻŘŜ ǳƴŘŜǊ ǘƘŜ ƴŜǿ ǇŀǊŜƴǘ ƴƻŘŜΣ ȅƻǳ ƘŀǾŜ ǘƻ ǇǊŜǎǎ ǘƘŜ άƛƳǇƻǊǘέ ōǳǘǘƻƴ  or to select 

the corresponding menu item within the node specific pop-up menu. Executable nodes and test step 

nodes are interchangeable in the way that an exported executable node can be imported as a test 

step of the same type (i.e. Rendezvous Generic Publisher).     

2.2.3. FOLDER 

The folder  can contain any executable node and other folders. This node is also named group 

viewer since it offers a view on all console windows of direct dependent executable nodes in its detail 

view. This way it looks like a multiple-document interface (MDI) or desktop. Console windows can be 

ŀǊǊŀƴƎŜŘ ǘƘǊƻǳƎƘ ǘƘŜ ά²ƛƴŘƻǿέ ƳŜƴǳΤ ȅƻǳ ƘŀǾŜ ǘƘŜ ŎƘƻƛŎŜ ōŜǘǿŜŜƴ ƘƻǊƛȊƻƴǘŀƭƭȅΣ ǾŜǊǘƛŎŀƭƭȅ ŀƴŘ 

cascading arrangement.   

The folder view has its own toolbox where a button appears for every node type that can be added to 

the folder. The folder accepts other folders as well as any executable node (see below) as its 

dependants. When the start button is pressed while a certain folder within the project tree is 

selected, all its direct dependent executable nodes get started instead. The same, if the stop button 

on a selected folder is pressed, all its direct dependent executable nodes stop running.     

2.2.4. EXECUTABLE NODE 

The executable node is an embedded program module or represents an independent program or 

process that runs under the control of the OpenSphere application. The complexity of the executable 

nodes varies a lot; it may be a simple operating system command, a SQL processor or even a 

completely configurable Tibco Rendezvous application simulator to name only three of them. The 
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following table gives an overview of all executable nodes that can be added to a folder node. 

Depending on how your OpenSphere program was installed, some of these nodes however may not 

be available.    

Executable Type Description 

 OS Command Represents an operating system command   

 Executable Represents an independent program or a batch file. 

 RV Publisher This node acts as publisher for a single or collection of distinct Tibco 
Rendezvous message. It is easy configurable through its option dialog. 
Depending on the user settings, it re-sends the message on the chosen 
interval. The content of the published messages as well as the received replay 
message is be displayed in the console. The message can be imported, freely 
edited and saved to an external file using the in-built tree based message 
editor. 

 RV Subscriber This node subscribes to a Tibco Rendezvous subject or a subject hierarchy and 
receives corresponding messages. It is easy configurable through its option 
dialog. Depending on the user settings it buffers inbound messages and lets 
them display in the message editor dialog. It is also able to reply to received 
messages by sending one or several predefined reply and forward messages. 
Single messages or message collection can be imported, freely edited and 
saved to a file using the in-built tree based message editor. 

 RV Application 
Simulator 

The RV Application Simulator node is an extension of the RV Subscriber node 
and is useful where a dummy implementation of Rendezvous components 
such as adapters is needed to be able to test dependent programs. The nodes 
property dialog contains a mapper where the fields of the hypothetical 
inbound message can individually be assigned to fields of one or several 
outbound messages with different structure each. During program execution, 
the values of those fields are automatically copied from the source (inbound 
message) to the target field and those dynamically built messages are 
replayed or forwarded on the defined subject.        

 JMS Message 
Producer 

The JMS Message Producer allows you to send JMS messages and provides 
support for both the point-to-point and the publish/subscribe domains. You 
can import, modify or create the message to be sent, define the number of 
iterations and the interval to be observed between. 

 JMS Message 
Consumer 

The JMS Message Consumer allows you to receive JMS messages and 
provides support for both the point-to-point and the publish/subscribe 
domains 

 JMS Queue 
Browser 

The JMS Queue Browser acts as the JMS Message Consumer but is restricted 
to Queue and allow you to download all messages currently in the specified 
Queue without removing them. 

 Web Service 
Client (HTTP) 

This node is responsible for invoking sends SOAP messages over HTTP to 
invoke operations on remote web services. The component gets generated 
from a WSDL file the user has to choose. Available operations can be selected 
to create operation invocations with user defined arguments. The client is 
easily configurable and able to invoke different operations with different 
arguments, to repeat invocations, to store the responses etc. 

 Web Service 
Client (JMS) 

This node iǎ ǎƛƳƛƭŀǊ ǘƻ ǘƘŜ ŀōƻǾŜ ŘŜǎŎǊƛōŜŘ ά²Ŝō {ŜǊǾƛŎŜ /ƭƛŜƴǘ όI¢¢tύέ 
except that it uses JMS as the communication transport.  
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Executable Type Description 

 Web Service 
Server  

This program node simulates a web server that offers a set of web services 
that are dynamically added or removed. New service implementations are 
generated from a WSDL file chosen by the user. For each operation, the 
response can be freely defined and altered at any time. 

 SQL Processor The SQL Processor is used to perform SQL DML statements on a Oracle or any 
ODBC compatible database. 

The status of executable nodes within the project tree is shown by a small icon that gets applied on 

top of the regular node icon. The following status icons can appear. 

 initializing  

 initialized 

 running  

 terminated with error 

 successfully performed 

2.2.5. DATABASE 

 The database node represents a database and does not have any dependent inside the project 

tree. Instead of this it has its own tree structure that is shown in a separate area of the detail view. 

The database tree contains different folders that group database objects by their type. One folder 

contains all tables whereas another folder contains all views etc. The database node is a top level 

node and can be added to the project node only. 

2.2.6. TEST SUITE 

 The folder like test suite node is used to logically group series of test cases and run them in the 

desired order. Test suites with all their dependent nodes can be published after execution in order to 

be shown within a web browser. Test suites only appear as direct dependents of the project node 

only.  

2.2.7. TEST CASE 

 Test cases depend on test suites and represent a certain number of test steps that are part of a 

graphical definable process flow. The test case detail view is composed of several tabbed panels that 

show a different aspect of the test case each. You have the choice between the test flow chart (test 

logic), the test step consoles (execution monitor) and the result panel. 

2.2.8. TEST STEP 

Test steps (test tasks) are part of a test case and controlled by its test flow engine. The appearance of 

them within the project tree depends on their functionality, which may be as simple as the sleeper 

test step  that interrupts the test case processing during the specified time; or it may be complex 
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such as the SQL Comparison test step  that compares and reports data retrieved from one or two 

distinct databases. 

2.3. SUBSTITUTION VARIABLES 

OpenSphere lets you define global substitution variables on project level within a single dialog. This is 

useful where same variable values are defined at several places within the project. The substitution 

variable dialog is invoked from the main menu through the menu item Project > Substitution 

±ŀǊƛŀōƭŜǎΧ or directly from the popup menu of the project node.  

 

 

You may define as many substitution variables as you like, 

ǎƛƳǇƭȅ ŎƭƛŎƪ ǘƘŜ άŀŘŘέ  button and enter the variable 

name choose its type in the dialog shown beside. The 

variable value has to be defined on the table row as soon as 

ǘƘŜ ŘƛŀƭƻƎ ƎŜǘǎ ŎƭƻǎŜŘ ōȅ ǇǊŜǎǎƛƴƎ ǘƘŜ άhYέ ōǳǘǘƻƴΦ ¢Ƙŀǘ 

value will be used for replacing any string that corresponds 

to the variable name enclosed by the specified prefix and 

postfix. Given the example substitution variable definition from the dialog shown above, the string 

ά҈Ƙƻǎǘ҈έ ŜƴǘŜǊŜŘ ƻƴ ŀƴ hǊŀŎƭŜ ŎƻƴƴŜŎǘ ŘƛŀƭƻƎ ǿƻǳƭŘ ōŜ ǊŜǇƭŀŎŜŘ ōȅ άƭȊǳллсέΦ Lƴ ŎŀǎŜ ǘƘŜ ǾŀǊƛŀōƭŜ ƛǎ 

ƴƻǘ ƻŦ ǘȅǇŜ ά{ǘǊƛƴƎέΣ ǘƘŜ ǾŀƭǳŜ Ƴŀȅ ōŜ ŘŜǊƛǾŜŘ ƻǊ ƛƴŎǊŜƳŜƴǘŜŘ ŀŎŎƻǊŘƛƴƎ ǘƻ ǘƘŜ ŘŜǎŎǊƛǇǘƛƻƴ ƛƴ ǘƘŜ 

following sections. 


